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Utiliser LibreOffice sur un Mac

Sur Mac, certaines touches et certains éléments de menu sont différents de ceux utilisés sous 
Windows ou Linux. Le tableau ci-dessous donne quelques substitutions courantes pour les instruc-
tions de ce chapitre. Pour une liste plus détaillée, voyez l’Aide de l’application.

Windows ou Linux Équivalent Mac Effet

Sélection du menu 
Outils > Options

LibreOffice > Préférences Accès aux options de configuration

Clic droit
Control+clic ou clic droit 
selon la configuration de l’ordinateur

Ouvre un menu contextuel

Ctrl (Control) ⌘ (Command) Utilisé avec d’autres touches

F5 Shift+⌘+F5 Ouvre le navigateur

F11 ⌘+T Ouvre l’onglet Styles du volet latéral
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Documents multi-pages

Les documents Draw, comme les documents de présentation Impress, peuvent contenir plusieurs 
pages. Cela vous permet de créer un dessin qui comporte plusieurs parties, mais qui est stocké 
dans un seul fichier.

Lorsque des pages sont insérées dans un document Draw, elles sont automatiquement nommées 
Page 1, Page 2, et ainsi de suite. Si vous modifiez l’ordre des pages, leurs noms changent en 
conséquence. Par conséquent, si vous voulez facilement identifier chaque page, il est recomman-
dé de les renommer en leur donnant un nom significatif.

Utiliser le volet page

Par défaut, le volet page apparaît ancré à gauche de l’espace de travail lorsque vous ouvrez Draw 
et affiche chaque page du document sous forme d’aperçu. Si le volet n’apparaît pas, sélectionnez 
Affichage > Volet page dans la barre de menu.

Remarque

Le volet page est appelé Pages lorsqu’il est ancré à gauche de l’espace de travail.

Volet Pages Espace de travail

Barre de menu Barre d’outils Standard

Volet latéral

Onglets des couchesBarre d’état

Barre d’outils Dessin

Barre d’outils Ligne et remplissage

Fermeture des volets

Figure 1 : L’espace de travail de LibreOffice Draw

Les actions suivantes sont possibles dans le volet page :

• Sélectionnez une page grâce à une des méthodes suivantes pour qu’elle apparaisse dans 
l’espace de travail où vous pourrez la modifier :

– cliquez sur l’aperçu d’une page dans le volet page ;
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– appuyez sur la touche F5 ou sélectionnez Affichage > Navigateur dans la barre de menu
pour ouvrir le navigateur (Figure 2) puis cliquez sur le nom d’une page ;

– ouvrez l’onglet Navigateur dans le volet latéral (Figure 3) en cliquant sur son icône ( ) 
et cliquez sur le nom de la page.

Figure 2 : Le navigateur dans Draw

Figure 3 : L’onglet Navigateur 
dans le volet latéral

• Cliquez sur l’aperçu d’une page et faites-le glisser pour modifier l’ordre des pages dans le 
document.

• Cliquez sur la ligne de séparation entre le volet page et l’espace de travail et faites-la glisser 
pour modifier la largeur du volet page.

• Cliquez sur le bouton au milieu de la ligne de séparation (encadrés dans la Figure 1) pour 
masquer ou afficher le volet page.

• Maintenez appuyée la touche Ctrl et faites un double-clic sur le titre du volet page pour 
faire flotter ou ancrer le volet. Vous pouvez aussi cliquer sur sa barre de titre et la faire glis-
ser.

• Faites un clic droit sur l’aperçu d’une page et utilisez les commandes du menu contextuel 
pour insérer (Page suivante), supprimer, renommer, couper, copier et coller une page.

• Cliquez sur Page dans la barre de menu pour réaliser une des actions proposées par le 
sous-menu déroulant :

– choisissez Page suivante pour insérer une page après la page courante et la sélection-
ner,

– choisissez Dupliquer la page pour insérer un double de la page sélectionnée dans le vo-
let page,

– choisissez Insérer une page à partir d’un fichier pour ouvrir la boîte de dialogue Insérer
un fichier où vous pourrez rechercher le fichier souhaité et l’insérer en cliquant sur le bou-
ton Ouvrir,

– choisissez Renommer la page pour changer le nom de la page sélectionnée dans le vo-
let page,

– choisissez Supprimer la page pour supprimer la page sélectionnée dans le volet page,
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– choisissez Déplacer puis Au début, Vers le haut, Vers le bas ou À la fin dans le menu 
déroulant pour déplacer la page sélectionnée dans le volet page,

– choisissez Naviguer puis À la première page, À la page précédente, À la page sui-
vante ou À la dernière page pour sélectionner une autre page dans le volet page.

Pages maîtresses

Une page maîtresse est une page qui va être utilisée comme point de départ pour les autres pages
de votre document. C’est une notion similaire à celle de style de page qui se trouve dans Writer et 
elle contrôle le formatage de base de toutes les pages qui sont basées sur elle. Vous pouvez défi-
nir plusieurs pages maîtresses et les assigner librement aux différentes pages de votre document 
et leur donner un aspect différent, par exemple en concevant une page maîtresse pour le titre et 
un autre pour le contenu.

Une page maîtresse va apporter aux pages auxquelles elle est attribuée un certain nombre de ca-
ractéristiques. Elle va définir des attributs de formatage, comme la couleur, l’image ou le dégradé 
d’arrière-plan de la page et le format par défaut des textes. Il va également définir des objets qui 
s’afficheront en arrière-plan, comme un logo, des lignes décoratives ou d’autres éléments gra-
phiques, des blocs de texte standard ou un champ représentant le numéro de la page, la date 
d’ouverture du document ou le nom du fichier, par exemple.

Remarque

LibreOffice utilise plusieurs termes pour un même concept : masque de diapo, ébauche de 
diapo, diapositive maîtresse ou page maîtresse sont équivalents. Tous font référence à une 
page utilisée pour créer d’autres pages. Il peut être nécessaire d’utiliser ces différents 
termes dans l’Aide pour trouver l’information recherchée.

Affichage de la page maîtresse

Pour ajouter du texte, des objets ou des champs à une page maîtresse, choisissez Affichage > 
Masque dans la barre de menu pour passer en mode d’affichage masque de page. La barre d’ou-
tils Mode Maître (Figure 3) s’ouvre. Si ce n’est pas le cas, sélectionnez Affichage > Barre d’outils
> Mode maître dans la barre de menu. Le volet page affiche l’aperçu des différents masques de 
page définis, à la place des pages du document.

Pour retourner au mode d’affichage normal, cliquez sur Fermer le mode maître ( ) dans la barre
d’outils ou choisissez Affichage > Normal dans la barre de menu.

Nouvelle diapo maîtresse Supprimer le masque Renommer le masque

Fermer le mode maître

Figure 4 : La barre d’outils Mode maître

Le formatage et l’insertion d’objets et de champs s’effectuent de la même façon que dans une 
page normale : voir les autres chapitres du Guide Draw pour plus d’informations.
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Créer une page maîtresse

Chaque dessin que vous créez comporte une page maîtresse par défaut, mais vous pouvez en 
créer d’autres pour modifier l’apparence de certaines pages particulières de votre document.

 1) Passez en mode maître en sélectionnant Affichage > Masque dans la barre de menu.

 2) Cliquez sur l’icône Nouvelle diapo maîtresse  de la barre d’outils Mode maître.

La nouvelle page maîtresse est automatiquement sélectionnée pour vous permettre d’y ajouter de 
nouveaux éléments afin de donner un nouvel aspect à vos pages.

Renommer une page maîtresse

Chaque masque de page créé a comme nom par défaut Standard 1, Standard 2, et ainsi de suite. 
Il est recommandé de les renommer pour leur donner un nom plus significatif. Vous pouvez égale-
ment renommer la page maîtresse créée avec le document, qui a par défaut le nom Standard.

 1) Passez en mode maître en sélectionnant Affichage > Masque dans la barre de menu.

 2) Cliquez sur l’icône Renommer le masque  de la barre d’outils Mode maître, ou faites un 
clic droit sur l’aperçu dans le volet page et choisissez Renommer le masque dans le menu 
contextuel. La boîte de dialogue Renommer la diapo maîtresse s’ouvre (Figure 5).

 3) Saisissez le nouveau nom et cliquez sur OK pour enregistrer le nouveau nom et refermer la 
boîte de dialogue.

Figure 5 : La boîte de dialogue Renommer la diapo maîtresse

Supprimer une page maîtresse

L’entrée Supprimer le masque du menu contextuel et l’icône correspondante  de la barre d’ou-
tils Mode maître ne sont actives qui si votre dessin comporte plus d’une page maîtresse. Il n’est 
pas possible de supprimer la page maîtresse par défaut qui a été créée avec votre dessin.

 1) Passez en mode maître en sélectionnant Affichage > Masque dans la barre de menu.

 2) Sélectionnez la page maîtresse que vous voulez supprimer dans le volet page. Cliquez sur 
l’icône Supprimer le masque  de la barre d’outils Mode Masque, ou faites un clic droit 
sur l’aperçu dans le volet page et choisissez Supprimer le masque dans le menu contex-
tuel.

Insérer des champs

Vous pouvez insérer des champs sur une page maîtresse en sélectionnant Insertion > Champ 
dans la barre de menu puis en choisissant un type de champ dans le menu déroulant. Les champs
suivants peuvent être insérés dans une page maîtresse.

• Date (fixe) : insère la date courante dans la page maîtresse en tant que valeur fixe. La date 
n’est pas mise à jour automatiquement.
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• Date (variable) : insère la date courante dans la page maîtresse en tant que valeur variable. 
La date est mise à jour automatiquement à l’ouverture du fichier.

• Heure (fixe) : insère l’heure courante dans la page maîtresse en tant que valeur fixe. L’heure 
n’est pas mise à jour automatiquement.

• Heure (variable) : insère l’heure courante dans la page maîtresse en tant que valeur variable.
L’heure est mise à jour automatiquement à l’ouverture du fichier.

• Auteur : insère le nom et le prénom de l’auteur du document. Cette information provient de 
Outils > Options > LibreOffice > Données d’identité où vous pouvez la saisir ou la modi-
fier

• Numéro de page : insère le numéro de la page où le champ est placé. Pour modifier le for-
mat de la numérotation :

 a) Sélectionnez Page > Propriétés dans la barre de menu pour ouvrir la boîte de dialogue 
Mise en page (Figure 6). 

 b) Cliquez sur l’onglet Page et choisissez un format de numérotation dans la liste déroulante 
Numéros de page de la section Paramètres de mise en page.

Figure 6 : La boîte de dialogue Mise en page

• Titre de la page : insère le nom de la page. Sélectionnez Page > Renommer dans la vue 
Normale pour changer le nom par défaut dans la boîte de dialogue Renommer la diapo (Fi-
gure 7).

Figure 7 : La boîte de dialogue Renommer la diapo

• Nombre de pages : insère le nombre total de pages de votre dessin.
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• Nom de fichier : insère le nom du fichier contenant le dessin. Il n’apparaît qu’après enregis-
trement du document.

Éditer le format d’un champ

Le format des champs Date, Heure, Auteur et Nom de fichier peut être édité de la manière sui-
vante dans une page maîtresse :

 1) Cliquez sur le champ pour le sélectionner.

 2) Sélectionnez son contenu.

 3) Choisissez Édition > Champ dans la barre de menu pour ouvrir la boîte de dialogue Éditer 
le champ (Figure 8).

 4) Choisissez une option dans les listes déroulantes Langue et Format.

 5) Cliquez sur OK pour enregistrer les modifications et refermer la boîte de dialogue.

Figure 8 : La boîte de dialogue Éditer le champ

Attribuer des pages maîtresses

Lorsque votre dessin comporte plusieurs pages maîtresses, vous pouvez attribuer une page maî-
tresse différente à chaque page du dessin.

 1) Assurez-vous que vous êtes en mode d’affichage normal (Affichage > Normal dans la barre
de menu) et sélectionnez la page à laquelle vous voulez attribuer une nouvelle page maî-
tresse.

 2) Faites alors un clic droit dans l’espace de travail et choisissez Changer de diapo maîtresse 
dans le menu contextuel. La boîte de dialogue Diapos maîtresses disponibles s’ouvre (Fi-
gure 9).

 3) Si nécessaire, l’option Échanger la page d’arrière-plan permet d’attribuer la page maîtresse 
sélectionnée à toutes les pages du document.

 4) Si nécessaire, l’option Supprimer les arrière-plans inutilisés permet de supprimer de la boîte 
de dialogue toutes les pages maîtresses qui n’ont pas été attribuées à une page du docu-
ment.

 5) Dans le cas où le masque figure dans les choix proposés, sélectionnez-le, puis validez par 
OK.
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Figure 9 : La boîte de dialogue Diapos maîtresses disponibles

Charger des pages maîtresses depuis les modèles

Il est possible d’utiliser des pages maîtresses qui sont définies dans des modèles disponibles dans
LibreOffice. Toutes les pages maîtresses chargées dans votre dessin sont adaptées à la taille de la
page utilisée par celui-ci. De ce fait, certaines images peuvent être étirées pour s’y adapter.

 1) Passez en mode maître en sélectionnant Affichage > Masque dans la barre de menu.

 2) Faites un clic droit sur la page maîtresse affichée dans votre dessin et choisissez Changer 
de diapo maîtresse dans le menu contextuel pour ouvrir la boîte de dialogue Diapos maî-
tresses disponibles (Figure 9).

 3) Cliquez sur le bouton Charger pour ouvrir la boîte de dialogue Charger la diapo maîtresse 
(Figure 10).

 4) Choisissez une catégorie de modèles dans la liste Catégories.

 5) Sélectionnez une page maîtresse dans la liste Modèles. Un aperçu de celle-ci s’affiche sous 
les deux listes.

 6) Cliquez sur OK pour refermer la boîte de dialogue Charger la diapo maîtresse. Les pages 
maîtresses du modèle choisi s’affichent dans la boîte de dialogue Diapos maîtresses dispo-
nibles.

 7) Choisissez la page maîtresse que vous voulez utiliser dans la section Sélectionnez une 
ébauche de diapo.
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Figure 10 : La boîte de dialogue Charger la diapo maîtresse

 8) Si nécessaire, l’option Échanger la page d’arrière-plan permet d’attribuer la page maîtresse 
sélectionnée à toutes les pages du document.

 9) Si nécessaire, l’option Supprimer les arrière-plans inutilisés permet de supprimer de la boîte 
de dialogue toutes les pages maîtresses qui n’ont pas été attribuées à une page du docu-
ment.

 10) Cliquez sur OK pour affecter la page maîtresse choisie à la page de votre dessin et refermer 
la boîte de dialogue.

Modèles

Un modèle est un prototype que vous utilisez pour créer d’autres documents. Par exemple, vous 
pouvez créer un modèle pour des dessins professionnels avec le logo et le nom de votre société 
sur la première page et les suivantes avec seulement le nom.

Les modèles peuvent contenir tout ce qu’un document ordinaire peut comporter, par exemple du 
texte, des images, un ensemble de styles et des informations de paramétrage propres à l’utilisa-
teur telles que des unités de mesure, une langue, l’imprimante par défaut et une personnalisation 
des barres d’outils et des menus.

• Vous pouvez créer un modèle particulier pour chaque type de document (texte, classeur, 
dessin ou présentation).
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• Si vous ne spécifiez pas de modèle quand vous commencez un nouveau dessin ou un nou-
veau document, celui-ci sera basé sur un ensemble de propriétés incorporées par défaut à 
LibreOffice.

• Vous pouvez créer un modèle par défaut pour vos dessins. Voir « Modèle par défaut », 
page 12 pour plus d’informations.

• Pour plus d’informations sur les modèles et les autres sources de modèles, voir le chapitre 3,
Styles et Modèles, du Guide du débutant.

Créer des modèles

 1) Ouvrez le dessin que vous voulez utiliser comme modèle ou ouvrez et modifiez un modèle 
dont vous souhaitez vous servir comme base pour le nouveau modèle.

 2) Ajoutez un contenu et des styles supplémentaires ou modifiez ceux qui existent.

 3) Pour enregistrer votre modèle, ouvrez la boîte de dialogue Enregistrer comme modèle (Fi-
gure 11) par une des méthodes suivantes :

Figure 11 : La boîte de dialogue Enregistrer comme modèle

– sélectionnez Fichier > Modèles > Enregistrer comme modèle dans la barre de menu ;

– cliquez sur le petit triangle à droite de l’icône Enregistrer ▼ dans la barre d’outils 
Standard et choisissez Enregistrer comme modèle dans le menu déroulant.

 4) Saisissez le nom de votre modèle dans le champ Nom du modèle.

 5) Sélectionnez une catégorie où vous souhaitez enregistrer votre modèle dans la liste corres-
pondante.

 6) Si vous voulez utiliser ce modèle comme modèle par défaut dans Draw, cochez l’option Défi-
nir comme modèle par défaut.

 7) Cliquez sur Enregistrer pour enregistrer votre modèle et refermer la boîte de dialogue.

Vous pouvez aussi utiliser la boîte de dialogue Enregistrer sous (Figure 12) pour enregistrer votre 
modèle :
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Figure 12 : La boîte de dialogue Enregistrer sous

 1) Ouvrez la boîte de dialogue Enregistrer sous par l’une des méthodes suivantes :

– sélectionnez Fichier > Enregistrer sous dans la barre de menu ;

– cliquez sur le petit triangle à droite de l’icône Enregistrer ▼ dans la barre d’outils 
Standard et choisissez Enregistrer sous dans le menu déroulant.

 2) Recherchez le dossier où sont enregistrés les modèles de LibreOffice. Celui-ci dépend du 
système d’exploitation de votre ordinateur et de son paramétrage.

! Attention

Quand vous utilisez la boîte de dialogue Enregistrer sous, vous devez placer vos modèles 
dans le dossier des modèles de LibreOffice pour que la boîte de dialogue Modèles les re-
connaisse et les retrouve.

 3) Dans la liste déroulante Type, choisissez Modèle de dessin ODF (*.otg).

 4) Saisissez le nom du fichier avec l’extension .otg dans le champ Nom du fichier.

 5) Cliquez sur OK pour enregistrer votre modèle et refermer la boîte de dialogue.
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Utiliser les modèles

Avec le centre de démarrage

Si LibreOffice n’est pas ouvert, ouvrez-le et choisissez un modèle parmi tous les modèles dispo-
nibles pour tous les modules (en cliquant sur Modèles) ou uniquement parmi ceux qui sont dispo-
nibles pour Draw (en cliquant sur la flèche à droite de Modèles pour en sélectionnant Modèles 
Draw dans la liste déroulante).

Avec la boîte de dialogue Modèles

Si Draw est déjà ouvert, au lieu d’utiliser les paramètres par défaut pour créer un nouveau dessin, 
partez d’un modèle :

 1) Ouvrez la boîte de dialogue Modèles (Figure 13) grâce à une des méthodes suivantes :

– sélectionnez Fichier > Nouveau > Modèles dans la barre de menu,

– sélectionnez Fichier > Modèles > Gérer les modèles dans la barre de menu,

– appuyez sur les touches Maj+Ctrl+N.

Figure 13 : La boîte de dialogue Modèles

 2) Utilisez les listes Filtres pour sélectionner les modèles du module Draw (Dessins) et une ca-
tégorie de modèle.

 3) Cliquez sur ouvrir pour créer le nouveau dessin dans Draw et refermer la boîte de dialogue.

Avec la boîte de dialogue d’ouverture de fichier

Si vous connaissez le dossier qui contient le modèle que vous voulez utiliser pour un nouveau des-
sin, procédez comme ceci :

 1) Sélectionnez Fichier > Modèles > Ouvrir un modèle dans la barre de menu pour ouvrir la 
boîte de dialogue Ouvrir (Figure 14).
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Figure 14 : La boîte de dialogue Ouvrir

 2) Recherchez le dossier où se situe le modèle.

 3) Sélectionnez le modèle que vous souhaitez utiliser.

 4) Cliquez sur Ouvrir pour ouvrir le modèle dans Draw et refermer la boîte de dialogue.

 5) Sélectionnez Fichier > Enregistrer sous dans la barre de menu pour ouvrir la boîte de dia-
logue Enregistrer sous (Figure 12, page 10).

 6) Dans la liste Type, sélectionnez Dessin ODF (*.odg) comme type de fichier.

 7) Saisissez un nom de fichier avec l’extension .odg dans le champ Nom du fichier.

 8) Cliquez sur Enregistrer pour sauvegarder votre nouveau dessin et refermer la boîte de dia-
logue.

Modèle par défaut

Si vous créez un nouveau dessin sans choisir de modèle, LibreOffice utilise un ensemble de pro-
priétés qui sont incorporées au logiciel. Mais vous pouvez définir n’importe quel modèle comme 
modèle par défaut, même un modèle que vous avez créé, du moment qu’il est situé dans une caté-
gorie affichée dans la boîte de dialogue Modèles (Figure 13, page 11).

Définir un modèle par défaut

Pour définir le modèle par défaut utilisé pour vos nouveaux dessins, procédez comme ceci :

 1) Ouvrez la boîte de dialogue Modèles (Figure 13, page 11) grâce à une des méthodes sui-
vantes :

– sélectionnez Fichier > Nouveau > Modèles dans la barre de menu,
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– sélectionnez Fichier > Modèles > Gérer les modèles dans la barre de menu,

– appuyez sur les touches Maj+Ctrl+N.

 2) Utilisez les listes Filtres pour sélectionner les modèles du module Draw (Dessins) et une ca-
tégorie de modèle.

 3) Sélectionnez un modèle

 4) Faites un clic droit sur le modèle sélectionné et choisissez Définir par défaut dans le menu 
contextuel. Aucune confirmation n’apparaît et le modèle choisi devient le modèle par défaut 
pour les nouveaux dessins. Le modèle par défaut est indiqué par une marque en haut à 
gauche de son icône (Figure 15).

Figure 15 : Le modèle par défaut dans la boîte de dialogue Modèles

 5) Cliquez sur Annuler pour refermer la boîte de dialogue. Le prochain dessin que vous crée-
rez sera basé sur le nouveau modèle par défaut.

Remarque

Si vous avez créé un nouveau dessin que vous voulez utiliser comme modèle par défaut, 
vous devez d’abord l’enregistrer comme modèle avant de pouvoir l’utiliser comme modèle 
par défaut. Voir « Créer des modèles », page 9, pour plus d’informations.

Rétablir le modèle par défaut d’origine

Pour rétablir les propriétés par défaut pour la création de nouveaux dessins :

 1) Ouvrez la boîte de dialogue Modèles (Figure 13, page 11) grâce à une des méthodes sui-
vantes :

– sélectionnez Fichier > Nouveau > Modèles dans la barre de menu,

– sélectionnez Fichier > Modèles > Gérer les modèles dans la barre de menu,

– appuyez sur les touches Maj+Ctrl+N.

 2) Faites un clic droit sur le modèle par défaut qui est indiqué par une marque en haut à gauche
de son icône (Figure 15).

 3) Sélectionnez Enlever par défaut dans le menu contextuel. Les propriétés par défaut de 
Draw pour la création de nouveaux dessins sont rétablies sans confirmation.

 4) Cliquez sur Annuler pour refermer la boîte de dialogue. Le prochain dessin que vous crée-
rez sera basé sur les propriétés par défaut intégrées à Draw.
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Éditer les modèles

Vous pouvez modifier les styles et le contenu des modèles, puis, si vous le désirez, appliquer de 
nouveau les styles modifiés du modèle aux dessins qui ont été créés en le prenant pour base.

Remarque

Vous ne pouvez réappliquer que les styles, pas le contenu du modèle.

Édition

 1) Ouvrez la boîte de dialogue Modèles (Figure 13, page 11) grâce à une des méthodes sui-
vantes :

– sélectionnez Fichier > Nouveau > Modèles dans la barre de menu,

– sélectionnez Fichier > Modèles > Gérer les modèles dans la barre de menu,

– appuyez sur les touches Maj+Ctrl+N.

 2) Retrouvez le modèle que vous voulez modifier et sélectionnez-le.

 3) Faites un clic droit sur le modèle sélectionné et choisissez Éditer dans le menu contextuel.

 4) Modifier le modèle comme vous le feriez pour n’importe quel dessin.

 5) Sélectionnez Fichier > Enregistrer dans la barre de menu ou appuyez sur les touches 
Ctrl+S pour enregistrer le modèle.

 6) Pour enregistrer le modèle modifié sous un nouveau nom, voyez « Créer des modèles », 
page 9 pour plus d’informations.

Mise à jour des documents créés à partir du modèle modifié

Quand vous ouvrez de nouveau pour la première fois un dessin qui a été créé à partir du modèle 
modifié, il vous est demandé de confirmer si vous voulez actualiser les styles utilisés dans votre 
dessin ou conserver les anciens styles (Figure 16).

Figure 16 : La boîte de dialogue de confirmation après modification d’un modèle

• Cliquez sur Actualiser les styles pour mettre à jour dans le document tous les styles qui ont
été modifiés dans le modèle et refermer la boîte de dialogue.

• Cliquez sur Conserver les anciens styles si vous ne voulez pas modifier les styles du do-
cument qui ont été modifiés dans le modèle et refermer la boîte de dialogue.
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Remarque

Si vous choisissez Conserver les anciens styles, la boîte de dialogue de confirmation 
n’apparaîtra plus aux ouvertures suivantes du document après modification du modèle sur 
lequel il est basé. Vous n’aurez pas d’autre occasion de mettre à jour les styles à partir du 
modèle.

Organiser les modèles

LibreOffice ne peut utiliser que les modèles qui sont dans ses dossiers de modèles (catégories). 
Vous pouvez créer de nouveaux dossiers de modèles (catégories) et les utiliser pour organiser vos
modèles. Par exemple, créer des catégories différentes pour différents projets ou différents clients.
Vous pouvez aussi importer et exporter des modèles.

Conseil

L’emplacement des dossiers de modèles de LibreOffice varie avec le système d’exploitation 
de votre ordinateur. Pour savoir où les dossiers des modèles sont stockés dans votre ordi-
nateur, sélectionnez Outils > Options dans la barre de menu puis ouvrez la page 
LibreOffice – Chemins de la boîte de dialogue Options.

Créer des dossiers de modèles

 1) Ouvrez la boîte de dialogue Modèles (Figure 13, page 11) grâce à une des méthodes sui-
vantes :

– sélectionnez Fichier > Nouveau > Modèles dans la barre de menu,

– sélectionnez Fichier > Modèles > Gérer les modèles dans la barre de menu,

– appuyez sur les touches Maj+Ctrl+N.

 2) Utilisez les listes Filtres pour sélectionner les modèles du module Draw (Dessins).

 3) Cliquez sur le bouton Paramètres et sélectionnez Nouvelle catégorie dans le menu dérou-
lant (Figure 17).

Figure 17 : Menu déroulant du bouton Paramètres

 4) Saisissez le nom de la nouvelle catégorie dans la boîte de dialogue qui s’ouvre.

 5) Cliquez sur OK pour enregistrer la nouvelle catégorie (dossier) dans LibreOffice et refermer 
la boîte de dialogue.
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Remarque

Il n’est pas possible de créer une nouvelle sous-catégorie à l’intérieur des catégories exis-
tantes de LibreOffice. Toute catégorie de modèles créée est ajoutée à la liste des catégories
dans la boîte de dialogue Modèles.

Renommer une catégorie

Il est recommandé de ne renommer que les catégories (dossiers) de modèles que vous avez 
créées. Renommer les dossiers de modèles de LibreOffice pourrait provoquer des problèmes avec
les autres modules.

 1) Ouvrez la boîte de dialogue Modèles (Figure 13, page 11) grâce à une des méthodes sui-
vantes :

– sélectionnez Fichier > Nouveau > Modèles dans la barre de menu,

– sélectionnez Fichier > Modèles > Gérer les modèles dans la barre de menu,

– appuyez sur les touches Maj+Ctrl+N.

 2) Utilisez les listes Filtres pour sélectionner les modèles du module Draw (Dessins) et la caté-
gorie que vous voulez renommer.

 3) Cliquez sur le bouton Paramètres et sélectionnez Renommer la catégorie dans le menu 
déroulant (Figure 17).

 4) Saisissez le nouveau nom de la catégorie dans la boîte de dialogue qui s’ouvre.

 5) Cliquez sur OK pour enregistrer la nouvelle catégorie (dossier) dans LibreOffice et refermer 
la boîte de dialogue.

Supprimer des dossiers de modèles

Il n’est pas possible de supprimer les dossiers de modèles fournis avec LibreOffice ou installés 
grâce au gestionnaire des extensions. Vous ne pouvez supprimer que les dossiers que vous avez 
créés.

 1) Ouvrez la boîte de dialogue Modèles (Figure 13, page 11) grâce à une des méthodes sui-
vantes :

– sélectionnez Fichier > Nouveau > Modèles dans la barre de menu,

– sélectionnez Fichier > Modèles > Gérer les modèles dans la barre de menu,

– appuyez sur les touches Maj+Ctrl+N.

 2) Utilisez les listes Filtres pour sélectionner les modèles du module Draw (Dessins) et la caté-
gorie que vous voulez renommer.

 3) Cliquez sur le bouton Paramètres et sélectionnez Supprimer la catégorie dans le menu dé-
roulant (Figure 17).

 4) Sélectionnez la catégorie que vous voulez supprimer dans la boîte de dialogue qui s’ouvre 
(Figure 18).

 5) Cliquez sur OK pour supprimer la catégorie et refermer la boîte de dialogue.

 6) Cliquez sur Oui pour confirmer la suppression du dossier.
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Figure 18 : La boîte de dialogue Supprimer une catégorie

Déplacer des modèles

Pour déplacer un modèle d’un dossier de modèles à un autre :

 1) Ouvrez la boîte de dialogue Modèles (Figure 13, page 11) grâce à une des méthodes sui-
vantes :

– sélectionnez Fichier > Nouveau > Modèles dans la barre de menu,

– sélectionnez Fichier > Modèles > Gérer les modèles dans la barre de menu,

– appuyez sur les touches Maj+Ctrl+N.

 2) Utilisez les listes Filtres pour sélectionner les modèles du module Draw (Dessins) et la caté-
gorie que vous voulez déplacer.

 3) Cliquez sur le bouton Déplacer (Figure 13, page 11) et la boîte de dialogue Choisir une caté-
gorie (Figure 19) s’ouvre.

Figure 19 : La boîte de dialogue Choisir une catégorie

 4) Faites votre choix parmi les catégories existantes ou créez une nouvelle catégorie en saisis-
sant son nom dans le champ prévu à cet effet.

 5) Cliquez sur OK pour déplacer le modèle et refermer la boîte de dialogue.
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Supprimer des modèles

Il n’est pas possible de supprimer les modèles fournis avec LibreOffice ou installés grâce au ges-
tionnaire des extensions. Vous ne pouvez supprimer que les dossiers que vous avez créés ou im-
portés. Cependant, les administrateurs du système peuvent supprimer ou ajouter manuellement 
des modèles dans le dossier d’installation de LibreOffice.

 1) Ouvrez la boîte de dialogue Modèles (Figure 13, page 11) grâce à une des méthodes sui-
vantes :

– sélectionnez Fichier > Nouveau > Modèles dans la barre de menu,

– sélectionnez Fichier > Modèles > Gérer les modèles dans la barre de menu,

– appuyez sur les touches Maj+Ctrl+N.

 2) Utilisez les listes Filtres pour sélectionner les modèles du module Draw (Dessins) et la caté-
gorie où se trouve le modèle.

 3) Faites un clic droit sur le modèle que vous voulez effacer et choisissez Supprimer dans le 
menu contextuel.

 4) Cliquez sur Oui pour confirmer la suppression du modèle et refermer la boîte de dialogue.

 5) Cliquez sur Annuler pour refermer la boîte de dialogue Modèles.

Importer des modèles

Si le modèle que vous désirez utiliser est situé à un emplacement différent, vous devez l’importer 
dans un dossier de modèles de LibreOffice.

 1) Ouvrez la boîte de dialogue Modèles (Figure 13, page 11) grâce à une des méthodes sui-
vantes :

– sélectionnez Fichier > Nouveau > Modèles dans la barre de menu,

– sélectionnez Fichier > Modèles > Gérer les modèles dans la barre de menu,

– appuyez sur les touches Maj+Ctrl+N.

 2) Cliquez sur le bouton Importer et la boîte de dialogue Choisir une catégorie (Figure 19) 
s’ouvre.

 3) Faites votre choix parmi les catégories existantes ou créez une nouvelle catégorie en saisis-
sant son nom dans le champ prévu à cet effet.

 4) Cliquez sur OK et une boîte de dialogue d’ouverture standard s’ouvre.

 5) Recherchez le modèle que vous voulez importer et cliquez sur Ouvrir. La boîte de dialogue 
se referme et le modèle apparaît dans la catégorie choisie.

Vous pouvez aussi cliquer sur le bouton Parcourir les modèles en ligne  pour ouvrir votre na-
vigateur à la page des modèles de LibreOffice où vous pourrez télécharger celui que vous souhai-
tez dans un dossier de votre ordinateur. Appliquez ensuite la procédure précédente pour importer 
ce modèle dans LibreOffice.
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Remarque

Le gestionnaire des extensions offre un moyen simple pour importer et installer des collec-
tions de modèles qui ont été empaquetés comme extensions. Pour plus d’informations sur le
gestionnaire des extensions, voir le Guide du débutant.

Exporter des modèles

 1) Ouvrez la boîte de dialogue Modèles (Figure 13, page 11) grâce à une des méthodes sui-
vantes :

– sélectionnez Fichier > Nouveau > Modèles dans la barre de menu,

– sélectionnez Fichier > Modèles > Gérer les modèles dans la barre de menu,

– appuyez sur les touches Maj+Ctrl+N.

 2) Utilisez les listes Filtres pour sélectionner les modèles du module Draw (Dessins) et la caté-
gorie où se trouve le modèle.

 3) Sélectionnez le modèle que vous voulez exporter et cliquez sur le bouton Exporter. Une 
boîte de dialogue de sélection de dossiers s’ouvre.

 4) Recherchez le dossier où vous voulez exporter le modèle et cliquez sur Sélectionner un 
dossier. La boîte de dialogue se referme et le modèle apparaît dans le dossier choisi.

 5) Cliquez sur OK pour refermer la boîte de dialogue d’information.

Couches multiples

Les couches de LibreOffice Draw vous permettent d’assembler dans une page de dessin des élé-
ments qui sont liés. Vous pouvez considérer les couches comme des espaces de travail individuels
que vous pouvez masquer à l’affichage, masquer à l’impression ou verrouiller.

Les couches ne déterminent pas l’ordre d’empilement des objets dans votre dessin, sauf pour les 
objets de la couche Contrôles qui sont toujours placés devant ceux des autres couches. L’ordre 
d’empilement des objets de votre page de dessin est déterminé par l’ordre de leur création. Vous 
pouvez le modifier en sélectionnant Forme > Disposition dans la barre de menu. Pour gérer les 
empilements d’objets, voir le chapitre 5, Combiner plusieurs objets.

Les couches apparaissent sous forme d’onglets en bas de l’espace de travail, au-dessus de la 
barre d’état. Cliquez sur un onglet pour sélectionner la couche correspondante. Des boutons de 
navigation sont disponibles si nécessaire à gauche de ces onglets. La Figure 20 montre la couche 
Mise en page sélectionnée.

Figure 20 : Les onglets des couches
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Remarque

Il est possible de verrouiller une couche pour protéger son contenu ou de la masquer à l’affi-
chage ou à l’impression. Une couche, au moment de sa création, est ajoutée à toutes les 
pages de votre document. Cependant, lorsque vous ajoutez un objet à une couche, il n’est 
ajouté qu’à la page en cours.

Si vous voulez qu’un objet apparaisse sur toutes les pages (le logo d’une société par 
exemple), ajoutez-le à la page maîtresse en sélectionnant Affichage > Masque dans la 
barre de menu. Pour revenir à votre dessin, choisissez Affichage > Normal (voir « Pages 
maîtresses » page 3).

Couches par défaut

LibreOffice Draw dispose par défaut de trois couches qui ne peuvent être ni supprimées, ni renom-
mées.

• Mise en page est l’espace de travail par défaut et détermine l’emplacement de l’ensemble 
des objets de votre dessin.

• Contrôles est utilisée pour les contrôles de formulaire auxquels vous associez une action, 
mais que vous ne voulez pas voir apparaître à l’impression. Modifiez alors cette couche pour
qu’elle ne soit pas imprimable. Les objets de cette couche sont toujours situés à l’avant des 
objets des autres couches.

• Lignes de cote est la couche où les lignes de cote sont dessinées. En modifiant les attributs 
de cette couche, vous pouvez facilement faire apparaître ou masquer ces lignes de cote.

En mode d’affichage Masque, la couche Objets d’arrière-plan est celle où vous pouvez placer les 
objets que vous voulez voir apparaître sur toutes les pages de votre dessin, par exemple la date, 
le numéro de page, le titre du dessin, etc.

Insérer une couche

 1) Sélectionnez Insertion > Couche dans la barre de menu, ou faites un clic droit en bas de 
l’espace de travail (où se trouvent les onglets des couches ou à leur droite) et choisissez In-
sérer une couche dans le menu contextuel pour ouvrir la boîte de dialogue Insérer une 
couche (Figure 21).

 2) Saisissez, dans le champ Nom, un nom de couche plus significatif que le nom par défaut. 
Vous pouvez saisir, dans les champs correspondants, un titre et une description pour faciliter
la compréhension de votre dessin.

 3) Cochez l’option Visible pour que les objets de cette couche soient visibles à l’écran. Si cette 
option n’est pas cochée, le nom de la couche apparaît en bleu sur son onglet.

 4) Cochez l’option Imprimable pour que les objets de cette couche soient imprimés lors d’une 
impression. Rendre une couche non imprimable est utile si vous voulez disposer d’une 
couche qui comprend des objets utiles à l’élaboration de votre dessin, comme des guides ou 
des annotations, mais que vous ne voulez pas voir apparaître à l’impression. Le nom de la 
couche est souligné dans son onglet si l’option Imprimable n’est pas cochée.

 5) Cochez l’option Verrouillée pour que les objets de cette couche ne puissent pas être suppri-
més, modifiés ou déplacés. Il peut être utile, par exemple, de protéger un plan de base et 
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d’utiliser une nouvelle couche pour ajouter des détails supplémentaires. Le nom d’une 
couche verrouillée est écrit en italique dans son onglet.

 6) Cliquez sur OK pour refermer la boîte de dialogue. La nouvelle couche est automatiquement 
active.

Figure 21 : La boîte de dialogue Insérer une couche

Modifier une couche

 1) Sélectionnez Format > Couche dans la barre de menu ou faites un clic droit sur l’onglet de 
la couche et choisissez Modifier la couche dans le menu contextuel pour ouvrir la boîte de 
dialogue Modifier la couche, qui est identique à celle de la Figure 21.

 2) Apportez les modifications voulues à la couche puis cliquez sur OK pour enregistrer les 
changements et refermer la boîte de dialogue.

Gérer les couches

Sélectionner une couche

Pour sélectionner une couche, cliquez sur son onglet en bas de l’espace de travail. Quand une 
couche est sélectionnée, les objets ajoutés à votre dessin ne le sont que dans celle-ci. Les 
contrôles de formulaire sont automatiquement ajoutés à la couche Contrôles et les lignes de cote à
la couche du même nom.

Si votre dessin comporte plusieurs couches, certaines ne peuvent pas être visibles dans la barre 
d’onglets. Utilisez les flèches de navigation à la droite de celle-ci pour atteindre la couche que vous
souhaitez utiliser ou modifier.

Masquer une couche

 1) Sélectionnez Format > Couche dans la barre de menu, faites un clic droit sur l’onglet de la 
couche et choisissez Modifier la couche dans le menu contextuel ou faites simplement un 
double-clic sur l’onglet de la couche pour ouvrir la boîte de dialogue Modifier la couche.

Couches multiples | 21



 2) Décochez l’option Visible et cliquez sur OK. Le nom de la couche apparaît en bleu sur son 
onglet. Les objets de cette couche ne sont alors plus visibles.

Vous pouvez également cliquer sur l’onglet d’une couche en maintenant appuyée la touche Maj 
pour la masquer.

Afficher une couche masquée

 1) Sélectionnez Format > Couche dans la barre de menu, faites un clic droit sur l’onglet de la 
couche et choisissez Modifier la couche dans le menu contextuel ou faites simplement un 
double-clic sur l’onglet de la couche pour ouvrir la boîte de dialogue Modifier la couche.

 2) Cochez l’option Visible et cliquez sur OK. Le nom de la couche reprend alors sa couleur par 
défaut. Les objets de cette couche sont alors visibles.

Vous pouvez également cliquer sur l’onglet d’une couche en maintenant appuyée la touche Maj 
masquée pour l’afficher à nouveau.

Verrouiller une couche

 1) Sélectionnez Format > Couche dans la barre de menu, faites un clic droit sur l’onglet de la 
couche et choisissez Modifier la couche dans le menu contextuel ou faites simplement un 
double-clic sur l’onglet de la couche pour ouvrir la boîte de dialogue Modifier la couche.

 2) Cochez l’option Verrouillée et cliquez sur OK. Le nom de la couche est alors souligné dans 
son onglet. Verrouiller une couche empêche toute modification dans celle-ci.

Vous pouvez également cliquer sur l’onglet d’une couche en maintenant appuyée la touche Ctrl 
masquée pour la verrouiller.

Déverrouiller une couche

 1) Sélectionnez Format > Couche dans la barre de menu, faites un clic droit sur l’onglet de la 
couche et choisissez Modifier la couche dans le menu contextuel ou faites simplement un 
double-clic sur l’onglet de la couche pour ouvrir la boîte de dialogue Modifier la couche.

 2) Décochez l’option Verrouillée et cliquez sur OK. Le nom de la couche n’est plus souligné 
dans son onglet.

Vous pouvez également cliquer sur l’onglet d’une couche en maintenant appuyée la touche Ctrl 
verrouillée pour la verrouiller.

Renommer une couche

Faites un clic droit sur l’onglet de la couche et choisissez Renommer la couche dans le menu 
contextuel pour que le nom de l’onglet soit modifiable. Saisissez alors le nouveau nom et cliquez 
hors de l’onglet pour enregistrer la modification.

Vous pouvez renommer directement une couche en maintenant appuyée la touche Alt pendant 
que vous cliquez sur son nom dans l’onglet.

Vous pouvez également renommer une couche en utilisant la boîte de dialogue de modification : 
voir « Modifier une couche » page 21.
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Supprimer une couche

Faites un clic droit sur l’onglet de la couche et choisissez Supprimer la couche dans le menu 
contextuel. Un message apparaît vous demandant de confirmer la suppression. Cliquez sur Oui 
pour supprimer la couche et tous les objets qu’elle contient.

Remarque

Vous ne pouvez supprimer ou renommer que les couches que vous avez créées. Les 
couches par défaut Mise en page, Contrôles et Lignes de cote ne peuvent pas être suppri-
mées.

Déplacer des objets d’une couche à une autre

Si un objet ou un groupe d’objets est sélectionné, la couche où il est situé est indiquée à l’extrémi-
té gauche de la barre d’état (Figure 20, page 19). Déplacer un objet ou un groupe d’objets d’une 
couche à une autre en utilisant une des méthodes suivantes :

• Cliquez sur l’objet et maintenez le bouton de la souris enfoncé jusqu’à ce que la forme du 
pointeur change. Si le changement n’intervient pas, déplacez légèrement la souris. Sans re-
lâcher le bouton, faites glisser la souris sur l’onglet affichant le nom de la couche dans la-
quelle vous souhaitez le placer. Relâchez le bouton. La position de l’objet ne change pas, 
mais la barre d’état affiche la nouvelle couche qui le contient.

Pour annuler l’opération sans déplacer l’objet, appuyez sur la touche Échap.

• Sélectionnez Édition > Couper dans la barre de menu ou faites un clic droit sur l’objet et 
choisissez Couper dans le menu contextuel. Cliquez sur l’onglet de la couche de destination
pour le rendre actif puis sélectionnez Édition > Coller dans la barre de menu ou faites un 
clic droit dans l’espace de travail et choisissez Coller dans le menu contextuel. La position 
de l’objet ne change pas, mais la barre d’état affiche la nouvelle couche qui le contient.

Cotations

Draw vous permet de dimensionner des objets (voir « Dessiner à l’échelle » page 28) et d’afficher
ces dimensions au moyen de lignes de cote, afin que votre document ait l’aspect d’un dessin in-
dustriel. Lorsque vous créez des lignes de cote, elles sont automatiquement placées dans la 
couche Lignes de cote : voir « Couches par défaut » page 20.

Configurer les lignes de cote

Deux méthodes permettent d’accéder aux options pour configurer les lignes de cote. Les deux mé-
thodes utilisent une boîte de dialogue semblable où vous pouvez modifier la longueur, le système 
de mesures et les propriétés des lignes d’attache d’une ligne de cote.

Grâce aux styles de dessin

 1) Utilisez l’une des méthodes suivantes pour accéder à vos styles de dessin afin d’ouvrir la 
boîte de dialogue Styles pour objets graphiques (Figure 22) :

– sélectionnez Format > Styles > Éditer le style dans la barre de menu,

– ouvrez l’onglet Styles et formatage du volet latéral en cliquant sur l’icône Styles et for-
matage  dans le volet latéral ou dans la barre d’outils Ligne et remplissage, ou en ap-
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puyant sur la touche F11, puis faites un clic droit sur un style et choisissez Modifier dans 
le menu contextuel.

 2) Ouvrez la page Cotation en cliquant sur son onglet.

 3) Effectuez les modifications souhaitées dans les diverses options des sections Ligne et Lé-
gende de la page Cotation.

 4) Cliquez sur OK pour enregistrer les changements et refermer la boîte de dialogue.

Pour redonner aux options de cotation les valeurs standard du modèle, ouvrez la boîte de dialogue
Styles pour objets graphiques comme indiqué ci-dessus et cliquez sur le bouton Standard.

Figure 22 : L’onglet Cotation de la boîte de dialogue Styles pour objets graphiques

Pour configurer une ligne de cote, faites un clic droit sur celle-ci et choisissez Cotations dans le 
menu contextuel. La boîte de dialogue Cotation s’ouvre (Figure 23). Un aperçu en bas de la boîte 
permet de voir l’effet des paramétrages effectués.

Grâce à la boîte de dialogue Cotations

 1) Dessiner une ligne de cote. Voir « Créer une ligne de cote », page 27, pour plus d’informa-
tions.

 2) Faites un clic droit sur la ligne de cote et sélectionnez Cotations dans le menu contextuel 
pour ouvrir la boîte de dialogue Cotation (Figure 23).

 3) Effectuez les modifications souhaitées dans les diverses options de cette boîte de dialogue. 
Ces options sont les mêmes que celles de l’onglet Cotation de la boîte de dialogue Styles 
pour objets graphiques.
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 4) Cliquez sur OK pour enregistrer les changements et refermer la boîte de dialogue.

Figure 23 : La boîte de dialogue Cotation

Options applicables aux lignes de cote

Les options de paramétrage des lignes de cote proposées par l’onglet Cotation de la boîte de dia-
logue Styles pour objets graphiques (Figure 22) et par la boîte de dialogue Cotation (Figure 23) 
sont présentées ci-dessous. Chaque boîte de dialogue offre un aperçu qui se modifie selon les 
choix effectués pour vous montrer comment la ligne de cote apparaîtra dans votre dessin. Un 
exemple de ligne de cote est proposé à la Figure 24.

Ligne de base
(non visible)Ligne de cote

Marqueurs de la ligne de base

Poignées inférieures de 
sélection de ligne d’attache

Ligne 
d’attache
gauche

Ligne 
d’attache
droite

Poignées supérieures de 
sélection de ligne d’attache

Figure 24 : Exemple de ligne de cote

Ligne
Cette section définit les distances entre la ligne de cote et les lignes d’attache, la ligne de 
base et l’objet. La ligne de base n’est pas visible dans le dessin, mais elle est indiquée par 
des points sur les lignes d’attache quand la ligne de cote est sélectionnée.
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– Distance de la ligne : ce champ indique la distance entre la ligne de cote et l’objet ou la 
ligne de base. Vous pouvez saisir une distance comprise entre −1 cm et 1 cm. Plus la va-
leur est proche de zéro, plus la ligne de cote est proche de l’objet ou de la ligne de base.

– Dépassement des repères  : ce champ indique la longueur des lignes d’attache gauche et 
droite au-dessus de la ligne de cote. Vous pouvez saisir une longueur entre −1 cm et 
1 cm. Une valeur positive étend les lignes d’attache au-dessus de la ligne de cote, tandis 
qu’une valeur négative laisse un espace entre les lignes d’attache et la ligne de cote.

– Écart des repères  : ce champ indique la distance entre le début des lignes d’attache 
gauche et droite et la ligne de base. Vous pouvez saisir une longueur entre −1 cm et 
1 cm. Une valeur positive laisse un espace entre le début des lignes d’attache et la ligne 
de base, tandis qu’une valeur négative étend les lignes d’attache au-delà de la ligne de 
base.

– Repère gauche  : ce champ indique un déplacement du début de la ligne d’attache gauche
par rapport à la ligne de base. Une valeur positive allonge la ligne d’attache vers la ligne 
de base, tandis qu’une valeur négative raccourcit la ligne d’attache.

– Repère droit  : ce champ indique un déplacement du début de la ligne d’attache droite par 
rapport à la ligne de base. Une valeur positive allonge la ligne d’attache vers la ligne de 
base, tandis qu’une valeur négative raccourcit la ligne d’attache.

– Mesurer en dessous de l’objet : cochez cette option pour déplacer le texte, les lignes de 
cote et d’attache en position symétrique par rapport à la ligne de base. Le texte reste affi-
ché dans le sens lisible (il n’est pas « symétrisé »).

– Décimales : ce champ indique le nombre de décimales utilisé pour afficher la longueur de 
la ligne de cote.

Légende
Cette section définit les propriétés du texte de la cote.

– Position du texte : ce champ détermine la position du texte par rapport à la ligne de cote 
et aux lignes d’attache. Les options VerticalAuto et HorizontalAuto doivent être désacti-
vées pour pouvoir modifier cette position.

– VerticalAuto : cochez cette option pour que Draw détermine automatiquement la position 
verticale optimale du texte de la ligne de cote.

– HorizontalAuto : cochez cette option pour que Draw détermine automatiquement la posi-
tion horizontale optimale du texte de la ligne de cote.

– Parallèle à la ligne : si cette option est cochée, le texte est parallèle à la ligne de cote, si-
non il est perpendiculaire à la ligne de cote.

– Afficher l’unité de mesure : si cette option est cochée, l’unité de mesure est affichée dans 
le texte de la ligne de cote. La liste déroulante permet de spécifier l’unité de mesure ou 
d’indiquer qu’elle est Automatique, c’est-à-dire qu’elle correspond à l’unité choisie dans 
Outils > Options > LibreOffice Draw > Général.
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Remarque

Les options de cotation sont toujours liées à la page de travail courante et stockées avec 
elle. Toutes les modifications que vous faites ne s’appliquent qu’à ce document. Les nou-
veaux documents commencent avec les propriétés standard de Draw. Si vous désirez utili-
ser ces options de cotation dans de futurs dessins, enregistrez celui-ci comme modèle.

Les poignées de sélection des lignes d’attache

Les poignées de sélection en haut et en bas des lignes d’attache servent à les prolonger au-delà 
de la limite de −1 à 1 cm imposée par les boîtes de dialogue décrites ci-dessus.

Les poignées de sélection des lignes d’attache (voir Figure 24, page 25) s’utilisent comme ceci :

• Poignées supérieures de sélection de ligne d’attache : sélectionnez une des poignées et ti-
rez-la pour augmenter ou diminuer la distance entre la ligne de cote et la ligne de base 
(champ Distance de la ligne).

• Poignées inférieures de sélection de ligne d’attache : sélectionnez une des poignées et tirez-
la pour augmenter ou diminuer la distance entre le début de la ligne d’attache du côté choisi 
et la ligne de base (champ Repère gauche ou Repère droit).

Conseil

Pour dessiner les lignes de cote d’un objet, il est recommandé d’utiliser la fonction zoom, les
lignes guide et les fonctions de capture pour pouvoir les positionner avec précision sur l’ob-
jet. Voyez le chapitre 3, Travailler avec les objets et les points des objets, pour plus d’infor-
mations.

Créer une ligne de cote

Pour tracer une ligne de cote :

 1) Cliquez sur le petit triangle à droite de l’icône Lignes et flèches (initialement ▼) de la 
barre d’outils Dessin pour ouvrir la palette Lignes et flèches (Figure 25) ou ouvrez l’onglet 
Forme du volet latéral.

Remarque

L’icône de la barre d’outils Lignes et flèches changent en fonction du dernier outil utilisé. De 
plus, vous pouvez la transformer en barre d’outils en cliquant en haut de la palette et en ti-
rant celle-ci dans l’espace de travail.

 2) Cliquez sur l’icône Ligne de cote ( ) et le pointeur de la souris prend alors normalement la
forme d’une croix, mais celle-ci peut changer selon le système d’exploitation de votre ordina-
teur.

Figure 25 : La barre d’outils Lignes et flèches
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 3) Cliquez à l’endroit où vous voulez que la ligne de cote débute et tirez le pointeur jusqu’à l’en-
droit où vous voulez que la ligne se termine. Relâchez le bouton de la souris : la ligne de 
cote est alors créée (Figure 26) dans la couche Lignes de cote. Voir « Couches par dé-
faut », page 20, pour plus d’informations.

4,5 cm

3 
cm

Figure 26 : Exemple de cotation

Si vous maintenez la touche Maj appuyée durant le tracé de la ligne, cela restreint son angle
à un multiple de 45 degrés (0, 45, 90, 135, etc.).

! Attention

Ceci est le comportement par défaut de la touche Maj. Cependant, si l’option Lors de la 
création ou du déplacement des objets de la section Contraindre les objets de la page 
LibreOffice Draw – Grille est cochée dans la boîte de dialogue Options (Outils > Options), 
l’action de la touche Maj est inversée. Les lignes seront automatiquement tracées avec un 
angle multiple de 45 degrés, à moins que la touche Maj ne soit appuyée.

Lors du dessin d’une ligne de cote, il faut distinguer le tracé de la ligne de cote et sa ligne de 
base (Figure 24, page 25). Le début et la fin de la ligne de base correspondent aux endroits 
où vous avez cliqué et où vous avez relâché le bouton de la souris. Le tracé de la ligne de 
cote s’éloigne de la ligne de base de la distance indiquée par le champ Distance de la ligne : 
voir « Configurer les lignes de cote » page 23.

Pour modifier le texte de la dimension, faites un double-clic sur une ligne de cote non sélectionnée 
pour mettre le texte en mode d’édition puis effectuez les changements voulus. Cliquez hors de la 
ligne de cote pour enregistrer ces modifications.

Vous pouvez également formater la ligne de cote comme n’importe quelle autre ligne, en utilisant 
l’outil Ligne de la barre d’outils Ligne et remplissage par exemple.

Pour configurer la ligne de cote, voir « Configurer les lignes de cote » page 23, pour plus d’infor-
mations.

Dessiner à l’échelle

Le dessin dans Draw s’effectue sur une page au format défini, A4 par exemple. Cependant, la taille
des objets que vous voulez dessiner ne correspond pas forcément à ce format. Vous pouvez alors 
utiliser une échelle (1:10 ou 2:1 par exemple) pour réduire ou agrandir votre dessin.

Vous pouvez spécifier une valeur d’échelle en ouvrant la page LibreOffice Draw – Général de la 
boîte de dialogue Options (Outils > Options) et en sélectionnant une valeur dans la liste dérou-
lante Échelle de dessin (Figure 27). La valeur par défaut de cette option est 1:1 ; elle correspond à 
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un dessin en taille réelle. Une modification de la valeur d’échelle se répercute dans les règles en 
haut et à gauche de votre dessin.

Figure 27 : La page LibreOffice Draw – Général de la boîte de dialogue Options

Une modification d’échelle n’a pas d’effet sur les opérations de dessin de base. Draw recalcule au-
tomatiquement les valeurs nécessaires. L’espacement des points de la grille est indépendant de 
l’échelle, la grille étant une aide visuelle et non un élément de dessin.

Une une échelle plus petite que 1 (1:4 par exemple) vous permet de dessiner des objets qui ne 
tiendraient pas dans votre feuille. Une échelle plus grande que 1 (4:1 par exemple) vous permet de
dessiner des petits objets plus précisément et de les restituer avec de plus grandes dimensions, 
afin qu’ils soient plus facilement compréhensibles. La Figure 28 illustre ces possibilités.

   
Figure 28 : Exemple d’une figure à 3 échelles différentes

Vues

Vous pouvez afficher plusieurs vues du même document. Elles peuvent avoir des réglages diffé-
rents des couches visibles, imprimables ou verrouillées, des facteurs de zoom différents, des ori-
gines différentes et vous pouvez même utiliser une page maîtresse et une page normale en même
temps. Comme le format du document ne peut contenir qu’une seule vue, assurez-vous que la vue
que vous voulez enregistrer est bien la vue active à ce moment-là.
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Pour ouvrir une nouvelle vue, sélectionnez Fenêtre > Nouvelle fenêtre dans la barre de menu. 
Disposez les fenêtres comme votre système d’exploitation le permet. Les fenêtres agissent sur le 
même document : une modification de celui-ci dans une fenêtre est immédiatement reflété dans 
les autres.

La galerie

Draw offre plusieurs images dans la galerie. Elles sont groupées par thèmes (par exemple, 
Flèches, Puces, Ordinateurs, Diagrammes, Environnement, etc.). L’onglet Galerie du volet latéral 
(Figure 29) liste des thèmes proposés. Cliquez sur un thème pour afficher ses images sous la liste.

Figure 29 : L’onglet Galerie dans le volet latéral

Vous pouvez créer des thèmes et ajouter des images aux nouveaux thèmes de la galerie. Pour 
plus d’informations sur la création de thèmes et l’ajout d’images, voir « Créer des thèmes et ajou-
ter des images », page 31.

Vous pouvez aussi supprimer des images et des thèmes de la galerie. Pour plus d’informations sur
la suppression de thèmes et d’images, voir « Supprimer des thèmes et des images de la gale-
rie », page 32.

Remarque

Il est recommandé de ne pas supprimer les images et les thèmes faisant partie de l’installa-
tion par défaut de LibreOffice. Leur suppression pourrait poser des problèmes dans d’autres 
modules où les thèmes et images par défaut de la galerie ont été utilisés.

Utiliser la galerie

 1) Utilisez une des méthodes suivantes pour ouvrir l’onglet Galerie du volet latéral (Figure 29) :

– cliquez sur l’icône de la galerie  dans le volet latéral,

– sélectionnez Insertion > Média > Galerie dans la barre de menu.

 2) Choisissez un thème dans la liste en haut de l’onglet Galerie.

 3) Utilisez une des méthodes suivantes pour insérer une image dans votre dessin :

– cliquez sur une image dans l’onglet Galerie et tirez-la dans votre dessin ;
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– faites un clic droit sur une image et choisissez Insérer dans le menu contextuel : l’image 
est placée au centre de votre dessin ;

– faites un clic droit sur une image et choisissez Copier dans le menu contextuel puis collez
le contenu du presse-papiers : l’image est placée au centre de l’espace de travail.

 4) Modifiez l’image de la galerie à votre convenance. Pour plus d’informations sur l’édition des 
images, voir le chapitre 6, Éditer des images.

Créer des thèmes et ajouter des images

 1) Utilisez une des méthodes suivantes pour ouvrir l’onglet Galerie du volet latéral (Figure 29, 
page 30) :

– cliquez sur l’icône de la galerie  dans le volet latéral,

– sélectionnez Insertion > Média > Galerie dans la barre de menu.

 2) Cliquez sur Nouveau thème en haut de l’onglet Galerie pour ouvrir la boîte de dialogue Pro-
priétés de « Nouveau thème » (Figure 30).

Figure 30 : La boîte de dialogue Propriétés de « Nouveau thème ».

 3) Tapez un nom significatif dans le champ de saisie à la place de Nouveau thème.

 4) Cliquez sur OK pour enregistrer le nouveau thème et refermer la boîte de dialogue.

 5) Faites un clic droit sur le nouveau nom que vous venez de créer et sélectionnez Propriétés 
dans le menu contextuel pour ouvrir de nouveau la boîte de dialogue Propriétés du thème, 
puis cliquez sur l’onglet Fichiers pour ouvrir la page correspondante (Figure 31).

 6) Cliquez sur le bouton Rechercher des fichiers pour ouvrir une boîte de dialogue qui vous 
permet de choisir un dossier.

 7) Recherchez le dossier qui contient les images que vous souhaitez utiliser puis cliquez sur 
Sélectionner un dossier.

La boîte de dialogue Sélectionner un dossier se referme et la liste des fichiers contenue 
dans le dossier choisi s’inscrit dans la boîte de dialogue Propriétés du thème.

 8) Choisissez les fichiers que vous voulez voir dans la galerie et cliquez sur Ajouter. Les fi-
chiers sélectionnés disparaissent de la liste et leurs images apparaissent dans la galerie.

Si vous voulez ajouter tous les fichiers de la liste, cliquez sur Ajouter tout. Tous les fichiers 
disparaissent de la liste et leurs images apparaissent dans la galerie.
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 9) Cliquez sur OK quand vous avez terminé pour refermer la boîte de dialogue Propriétés du 
thème.

Figure 31 : L’onglet Fichiers de la boîte de dialogue Propriété du thème.

Supprimer des thèmes et des images de la galerie

 1) Faites un clic droit sur un thème ou une image de la galerie.

 2) Sélectionnez Supprimer dans le menu contextuel.

 3) Cliquez sur Oui dans le message de confirmation qui apparaît et l’image ou le thème est 
supprimé.

Remarque

L’image est un lien vers un fichier et seul ce lien est supprimé de la galerie. Le fichier conte-
nant l’image vers lequel il pointait reste présent.

Mettre à jour la galerie

Toutes les images de la galerie sont des fichiers liés. De temps en temps, il peut être utile de 
mettre à jour un thème que vous avez créé pour vous assurer que tous les fichiers sont toujours 
présents. Pour cela, faites un clic droit sur le thème que vous avez créé et auquel vous avez ajouté
au moins un fichier et sélectionnez Actualiser dans le menu contextuel.

Renommer des thèmes

Pour renommer un thème que vous avez créé, faites un clic droit sur son nom et sélectionnez Re-
nommer dans le menu contextuel.
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Remarque

Il est recommandé de ne pas renommer les thèmes ou les images qui font partie de l’instal-
lation par défaut de LibreOffice. Un changement de nom pourrait poser des problèmes aux 
autres modules qui utiliseraient ces thèmes ou ces images par défaut.

Utiliser des objets de dessin avec la galerie

Il est possible d’ajouter des objets de dessin à la galerie aussi bien que des images :

 1) Sélectionnez le thème dans lequel vous voulez ajouter l’objet de dessin ou créez-en un nou-
veau.

 2) Cliquez sur l’objet de dessin que vous avez créé et tirez-le sur le thème choisi puis relâchez 
le bouton de la souris. Ces objets sont stockés dans un dossier de votre répertoire d’utilisa-
teur.

Une fois ajouté à la galerie, l’objet de dessin perd tout lien avec les styles de dessin et toutes ses 
propriétés sont définies par formatage direct. Il peut être inséré dans de nouveaux documents de 
Draw et utilisé dans les autres modules de LibreOffice de la même manière que les autres objets 
de la galerie.

Ajouter des thèmes complets

Il existe deux façons d’ajouter un thème complet à la galerie :

• S’il existe un dossier contenant des thèmes, vous pouvez ajouter un chemin vers celui-ci 
dans le champ Galerie de la page LibreOffice – Chemins de la boîte de dialogue Options 
(Outils > Options) et sélectionnez le dossier qui contient les thèmes. L’inconvénient de cette
méthode est que vous devez avoir des thèmes déjà installés. Il n’est pas possible de suppri-
mer un thème unique de ce dossier dans votre galerie, mais vous devez effacer tout l’en-
semble des thèmes en supprimant le chemin vers le dossier.

• Les thèmes de la galerie peuvent être installés sous forme d’extensions. Recherchez-les à 
https://extensions.libreoffice.org/.

Les couleurs

Draw (comme tous les modules de LibreOffice) utilise des palettes de couleurs pour représenter 
celles-ci. Vous pouvez créer des couleurs et des palettes de couleurs qui correspondent à vos be-
soins en modifiant les couleurs d’une palette, en y ajoutant des couleurs supplémentaires ou en 
composant des palettes de couleurs personnalisées.

Remarque

Tous les modules de LibreOffice utilisent le modèle de couleur RVB (Rouge, Vert, Bleu) pour
l’impression. Les contrôles CMJN (Cyan, Magenta, Jaune, Noir) ne sont proposés que pour 
faciliter la saisie de valeurs de couleur utilisant cette notation.

• Le modèle RVB (pour Rouge, Vert, Bleu) s’appuie sur le modèle de synthèse additive des 
couleurs et est conçu pour les écrans électroniques et les ordinateurs. Cela signifie que plus 
vous ajoutez de couleur, plus vous vous rapprochez du blanc. RVB utilise des échelles de 0 
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à 255, si bien que le noir correspond à R = 0, V = 0 et B = 0 tandis que le blanc correspond à
R = 255, V = 255 et B = 255.

• Le modèle CMJN (pour Cyan, Magenta, Jaune, Noir) est un modèle soustractif de couleurs 
où chaque couche d’encre absorbe une partie de la lumière pour obtenir du noir. Il est sur-
tout utilisé pour l’impression, c’est pourquoi les encres des imprimantes ont ces couleurs. 
CMJN utilise une échelle de 0 à 100. Si C = 100, M = 100, J = 100 et N = 100, on obtient une
couleur noire, mais si les quatre valeurs sont nulles, on obtient un blanc parfait.

• Le modèle HSB (ou TSL, pour Hue : Teinte, Saturation, Brightness : Luminosité) est une re-
présentation alternative du modèle RVB conçue pour être plus proche de la façon dont la vi-
sion humaine perçoit les couleurs. Vous pouvez utiliser les valeurs HSB pour affiner les cou-
leurs que vous avez créées.

Conseil

Vous trouverez plus d’informations sur les modèles et les valeurs de couleurs à https://fr.wi-
kipedia.org/wiki/Modèle_colorimétrique

Modifier les couleurs

Pour modifier la couleur des objets, vous utilisez des palettes de couleurs. Celles-ci sont installées 
avec LibreOffice et utilisées par tous les modules. Leur utilisation est la même pour tous les types 
d’objets, mais la façon d’y accéder varie avec le type d’objet sélectionné.

La barre de couleurs

Bien que LibreOffice offre des outils qui permettent de spécifier une couleur avec précision, il pro-
pose aussi une barre de couleurs qui vous donne la possibilité de changer rapidement la couleur 
d’un objet dans votre dessin. Par défaut, les couleurs disponibles dans la barre de couleurs sont 
celles de la palette Standard.

Remarque

Si vous avez changé la palette de couleurs dans les boîtes de dialogue Remplissage ou 
Ligne, la barre de couleurs affichera les couleurs actualisées de cette palette.

 1) Sélectionnez l’objet de votre dessin dont vous souhaitez modifier rapidement la couleur.

 2) Choisissez Affichage > Barre de couleurs dans la barre de menu pour ouvrir la barre de 
couleurs (Figure 32).

 3) Faites un clic gauche sur une couleur de la barre pour changer la couleur de remplissage de 
l’objet sélectionné et un clic droit pour changer sa couleur de contour.

 4) Pour supprimer la couleur de l’objet, cliquez sur la case en bas à gauche de la barre de cou-
leur (case blanche avec un X) : clic gauche pour supprimer la couleur de remplissage et droit
pour la couleur de contour.

 5) Pour refermer la barre de couleurs, choisissez Affichage > Barre de couleurs dans la barre
de menu.
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Figure 32 : La barre de couleurs

Couleurs de remplissage

Utilisez la boîte de dialogue Remplissage comme ceci :

 1) Sélectionnez un objet qui possède une surface de remplissage, par exemple un carré ou un 
triangle.

 2) Ouvrez la boîte de dialogue Remplissage grâce à l’une des méthodes suivantes :

– sélectionnez Format > Remplissage dans la barre de menu,

– faites un clic droit sur l’objet et sélectionnez Remplissage dans le menu contextuel,

– cliquez sur l’icône Remplissage  dans la barre d’outils Lignes et remplissage.

 3) Cliquez sur le bouton Couleur pour ouvrir la page correspondante (Figure 33).

Figure 33 : Palette de couleurs dans la boîte de dialogue Remplissage
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 4) Sélectionnez la palette de couleurs utilisée dans la liste déroulante de la section Couleurs.

 5) Cliquez sur une des couleurs affichées dans la palette ou parmi les couleurs récemment utili-
sées sous celle-ci.

 6) Cliquez sur OK pour enregistrer les modifications et refermer la boîte de dialogue. L’objet sé-
lectionné est rempli par la couleur choisie.

Utilisez la section Zone de l’onglet Propriétés du volet latéral (Figure 34) de la façon suivante :

 1) Sélectionnez un objet qui possède une surface de remplissage, par exemple un carré ou un 
triangle.

 2) Vérifiez que l’onglet Propriétés du volet latéral est visible et la section Zone déployée.

 3) Sélectionnez Couleur dans la liste déroulante Remplir.

 4) Cliquez sur le petit triangle ▼ à droite du bouton coloré Sélectionner la couleur à appli-
quer pour ouvrir la palette Couleur de remplissage.

Figure 34 : Palette Couleur de remplissage dans la section Zone 
de l’onglet Propriétés du volet latéral

 5) Sélectionnez la palette de couleurs à utiliser parmi celles qui sont proposées dans la liste dé-
roulante.

 6) Cliquez sur une des couleurs affichées dans la palette ou parmi les couleurs récemment utili-
sées sous celle-ci.

 7) La palette se referme et l’objet sélectionné est rempli par la couleur choisie.
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Utilisez la palette Couleur de remplissage des barres d’outils Ligne et remplissage ( ) et 
Dessin ( ) comme ceci :

 1) Sélectionnez un objet qui possède une surface de remplissage, par exemple un carré ou un 
triangle.

 2) Cliquez sur le petit triangle ▼ à droite du bouton coloré Couleur de remplissage pour ouvrir
la palette Couleur de remplissage.

 3) Sélectionnez la palette de couleurs à utiliser parmi celles qui sont proposées dans la liste dé-
roulante.

 4) Cliquez sur une des couleurs affichées dans la palette ou parmi les couleurs récemment utili-
sées sous celle-ci.

 5) La palette se referme et l’objet sélectionné est rempli par la couleur choisie.

Couleurs de lignes ou de bordures

Les palettes de couleurs pour les lignes et les bordures ont la même apparence et s’utilisent de la 
même manière que les palettes de couleurs de remplissage.

Utilisez la boîte de dialogue Ligne (Figure 35) de la façon suivante :

Figure 35 : Palette de couleur dans la boîte de dialogue Ligne

 1) Sélectionnez une ligne ou un objet dans votre dessin.

 2) Ouvrez la boîte de dialogue Ligne grâce à l’une des méthodes suivantes :

– sélectionnez Format > Ligne dans la barre de menu ;

– faites un clic droit sur la ligne ou l’objet et choisissez Ligne dans le menu contextuel ;
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– cliquez sur le bouton Ligne ( ) dans la barre d’outils Ligne et remplissage.

 3) Sélectionnez la palette de couleurs utilisée dans la liste déroulante Couleur de la section 
Propriétés de ligne.

 4) Cliquez sur une des couleurs affichées dans la palette ou parmi les couleurs récemment utili-
sées sous celle-ci.

 5) Cliquez sur OK pour enregistrer les modifications et refermer la boîte de dialogue. La ligne 
ou la bordure de l’objet sélectionné prend la couleur choisie.

Utilisez la section Ligne de l’onglet Propriétés du volet latéral de la manière suivante :

 1) Sélectionnez une ligne ou un objet dans votre dessin.

 2) Vérifiez que l’onglet Propriétés du volet latéral est visible et la section Ligne déployée.

 3) Cliquez sur le petit triangle ▼ à droite du bouton coloré Sélectionner la couleur de la ligne 
pour ouvrir la palette Couleur de Ligne.

Figure 36 : Palette Couleur de ligne dans la section Ligne 
de l’onglet Propriétés du volet latéral

 4) Sélectionnez la palette de couleurs utilisée dans la liste déroulante Couleur de la section 
Propriétés de ligne.

 5) Cliquez sur une des couleurs affichées dans la palette ou parmi les couleurs récemment utili-
sées sous celle-ci.

 6) La palette se referme et la ligne ou la bordure de l’objet sélectionné prend la couleur choisie

Utilisez la palette Couleur de ligne des barres d’outils Ligne et remplissage et Dessin ( ) comme 
ceci :

 1) Sélectionnez une ligne ou un objet dans votre dessin.
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 2) Cliquez sur le petit triangle à droite du bouton coloré Couleur de ligne ▼ pour ouvrir la 
palette Couleur de ligne.

 3) Sélectionnez la palette de couleurs à utiliser parmi celles qui sont proposées dans la liste dé-
roulante.

 4) Cliquez sur une des couleurs affichées dans la palette ou parmi les couleurs récemment utili-
sées sous celle-ci.

 5) La palette se referme et la ligne ou la bordure de l’objet sélectionné prend la couleur choisie.

Couleur des textes

On accède à la palette Couleur de police (Figure 37) grâce au bouton du même nom  dans la 
section Caractère de l’onglet Propriétés du volet latéral ou dans la barre d’outils Formatage du 
texte. Son apparence et son utilisation sont identiques à celles des palettes Couleur de remplis-
sage et Couleur de ligne décrites ci-dessus.

Figure 37 : Palette Couleur de police dans la section Caractère
de l’onglet Propriétés du volet latéral

Remarque

La barre d’outils Formatage du texte remplace automatiquement la barre d’outils Ligne et 
remplissage quand un texte est sélectionné dans votre dessin. Si elle n’apparaît pas, sélec-
tionnez Affichage > Barres d’outils > Formatage du texte dans la barre de menu.
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 1) Sélectionnez du texte dans un cadre de texte ou un objet de votre dessin.

 2) Cliquez sur le petit triangle à droite du bouton Couleur de police ▼ dans la section Ca-
ractère de l’onglet Propriétés du volet latéral (Figure 37) ou dans la barre d’outils Formatage
du texte. La palette Couleur de police s’ouvre.

 3) Sélectionnez la palette de couleurs à utiliser parmi celles qui sont proposées dans la liste dé-
roulante.

 4) Cliquez sur une des couleurs affichées dans la palette ou parmi les couleurs récemment utili-
sées sous celle-ci.

 5) La palette se referme et le texte sélectionné prend la couleur choisie.

Créer des couleurs

Toutes les couleurs que vous créez sont automatiquement placées dans la palette Personnalisé 
qui est disponible dans tous les modules de LibreOffice.

Remarque

LibreOffice n’utilise que le modèle de couleurs RVB pour l’impression en couleurs. Les va-
leurs des trois composantes de ce modèle sont affichées sous les zones d’aperçu (dans la 
boîte de dialogue Remplissage, voir Figure 33, page 35).

Pour créer une couleur personnalisée à l’aide de la boîte de dialogue Remplissage (Figure 33, 
page 35), procédez de la façon suivante :

 1) Ouvrez la boîte de dialogue Remplissage grâce à l’une des méthodes suivantes :

– sélectionnez Format > Remplissage dans la barre de menu,

– faites un clic droit sur l’objet et sélectionnez Remplissage dans le menu contextuel,

– cliquez sur l’icône Remplissage  dans la barre d’outils Lignes et remplissage.

 2) Cliquez sur le bouton Couleur pour ouvrir la page correspondante.

 3) Sélectionnez dans la liste déroulante une palette de couleurs prédéfinie qui contient une cou-
leur proche de celle que vous voulez définir.

 4) Choisissez dans la palette une couleur voisine de celle que vous voulez créer. Elle apparaît 
dans zone d’aperçu Nouveau.

 5) Si vous connaissez les valeurs des composantes rouge, verte et bleue de la couleur que 
vous voulez obtenir, saisissez-les dans les champs correspondants sous la zone d’aperçu 
Nouveau, dont la couleur change en fonction des valeurs saisies.

 6) Si vous ne les connaissez pas, créez votre couleur personnalisée de la manière suivante :

 a) Cliquez sur le bouton Choisir une couleur pour ouvrir la boîte de dialogue de même nom
(Figure 38).

 b) Sélectionnez une teinte dans la barre verticale puis cliquez sur le petit cercle dans le carré
en haut à droite de la boîte de dialogue et tirez-le jusqu’à l’emplacement de la couleur que
vous recherchez. Notez que les valeurs des champs des sections RVB, HSB et CMJN 
changent pour refléter la couleur à l’intérieur du cercle.
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Vous pouvez aussi modifier, si vous les connaissez, les valeurs dans les champs des sec-
tions RVB, HSB ou CMJN. Les valeurs des champs des autres sections, ainsi que la posi-
tion du cercle et la teinte sélectionnée dans la barre verticale s’adaptent en conséquence.

Figure 38 : La boîte de dialogue Choisir une couleur

 c) Cliquez sur OK pour refermer la boîte de dialogue Choisir une couleur. La couleur que 
vous avez choisie apparaît dans la zone d’aperçu Nouveau de la boîte de dialogue Rem-
plissage.

 7) Dans la boîte de dialogue Remplissage, cliquez sur le bouton Ajouter sous Palette person-
nalisée dans la section Couleur. Une boîte de dialogue Nom (Figure 39) s’ouvre.

Figure 39 : La boîte de dialogue Nom

 8) Saisissez un nom significatif pour votre couleur puis cliquez sur OK pour refermer cette boîte
de dialogue et la boîte de dialogue Remplissage. La couleur que vous avez choisie est ajou-
tée à la palette Personnalisé.

Remarque

Il est important de donner un nom significatif à la couleur que vous enregistrez dans la pa-
lette Personnalisé pour pouvoir la retrouver facilement. Si vous ne le faites pas, il recevra un
numéro hexadécimal qui rendra son identification plus difficile quand vous aurez plusieurs 
couleurs personnalisées.
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Supprimer des couleurs

Seules les couleurs que vous avez créées dans la palette Personnalisé peuvent être supprimées. 
Procédez comme ceci.

 1) Ouvrez la boîte de dialogue Remplissage grâce à l’une des méthodes suivantes :

– sélectionnez Format > Remplissage dans la barre de menu,

– faites un clic droit sur l’objet et sélectionnez Remplissage dans le menu contextuel,

– cliquez sur l’icône Remplissage  dans la barre d’outils Lignes et remplissage.

 2) Cliquez sur le bouton Couleur pour ouvrir la page correspondante.

 3) Sélectionnez la palette Personnalisé dans la liste déroulante.

 4) Sélectionnez la couleur que vous voulez supprimer.

 5) Cliquez sur le bouton Supprimer sous Palette personnalisée dans la section Couleur.

 6) Cliquez sur OK pour refermer la boîte de dialogue Remplissage.

Les courbes de Bézier

LibreOffice vous offre la possibilité d’utiliser des courbes de Bezier1 dans votre dessin. Une courbe
de Bézier est définie au moyen d’un point de départ, d’un point final et, si nécessaire, de points de 
contrôle. Les termes nœuds et ancres sont souvent utilisés pour les points de la courbe. Vous trou-
verez plus d’explication sur les fondements mathématiques des courbes de Bézier à https://fr.wiki-
pedia.org/wiki/Courbe_de_Bézier.

Les courbes de Bézier sont très utiles pour obtenir expérimentalement la forme de la courbe dési-
rée. En mode d’édition de points, vous pouvez la modeler en tirant les points avec la souris. Dans 
l’exemple de la Figure 40, la courbe part du point P0 dans la direction du premier point de contrôle 
P1 et arrive au point P3 en venant de la direction du deuxième point de contrôle P2. Plus un point 
de contrôle est éloigné d’un point de la courbe, plus la courbure en ce point est faible. Si un point 
de contrôle occupe la même position qu’un point de la courbe, il n’a aucune influence sur celui-ci.

P
1

P
0

P
2

P
3

Figure 40 : Exemple de courbe de Bézier

1 Les courbes de Bézier ont été inventées par Pierre Béziers, ingénieur à la Régie Nationale des Usines Renault dans 
les années 1960 dans le but de modéliser plus facilement les surfaces de carrosserie des véhicules.
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Tracer des courbes de Bézier

 1) Cliquez sur l’icône Courbe  dans la section Courbes et polygones de l’onglet Forme du 
volet latéral ou dans la barre d’outils Dessin.

 2) Cliquez au point de départ de la courbe et, sans relâcher le bouton de la souris, tirez le poin-
teur jusqu’à ce que la ligne ait la longueur désirée.

 3) Relâchez le bouton de la souris et déplacez le pointeur et le point final de la courbe jusqu’à 
la position souhaitée.

 4) Faites un double-clic pour terminer le tracé de la courbe.

Éditer une courbe de Bézier

 1) Cliquez une fois sur la courbe pour afficher les points de départ et d’arrivée. Le point de dé-
part est légèrement plus grand que le point d’arrivée.

 2) Placez le pointeur au-dessus d’un des deux points, cliquez et tirez. Si le point de contrôle 
n’est pas visible (cas du point d’arrivée juste après la création de la courbe), c’est lui que 
vous déplacez, sinon c’est l’extrémité de la courbe. Les points de contrôle sont représentés 
par des poignées rondes à l’extrémité d’une ligne en tirets qui part d’un point de la courbe 
(Figure 40 et Figure 41).

 3) Déplacez le pointeur en tirant le point de la courbe ou le point de contrôle jusqu’à obtenir la 
position ou la forme souhaitée

 4) Quand vous avez obtenu la forme souhaitée, cliquez dans l’espace de travail pour désélec-
tionner la courbe et quitter le mode d’édition.

Figure 41 : Points de contrôle d’une courbe de Bézier

Outils d’édition des points

Cliquez sur l’icône Points  de la barre d’outils Standard ou appuyez sur F8. Tant que cette fonc-
tion est active, la barre d’outils Éditer les points apparaîtra chaque fois qu’une courbe ou un poly-
gone (créé directement ou obtenu en convertissant une forme) sera sélectionné et se refermera 
quand il sera désélectionné. Les outils disponibles dans cette barre d’outils dépendent de l’objet 
sélectionné et du point en cours d’édition.

La Figure 42 montre les outils de la barre Éditer les points qui vous permettent de modifier la forme
d’une courbe de Bézier et qui sont présentés ci-dessous.
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Points Déplacer des points Insérer des points

Supprimer des points Convertir en courbe Fermer la courbe

Scinder la courbe Point d’inflexion Jonction lisse

Jonction symétrique Réduire les points

Figure 42 : La barre d’outils Éditer les points

Points 
Ce bouton vous permet d’activer ou désactiver le mode d’édition des courbes de Bézier. 
Dans le mode d’édition, chaque point de l’objet peut être sélectionné.

Déplacer les points 
Ce bouton active un mode dans lequel les points peuvent être déplacés. Cliquez sur un point
de la courbe et tirez-le à un autre emplacement. La courbe suit le mouvement des deux cô-
tés du point et les sections de part et d’autre du point changent de forme. Cliquez entre deux
points ou à l’intérieur d’une courbe fermée et pleine pour déplacer la courbe tout entière sans
la déformer.

Insérer des points 
Ce bouton active un mode dans lequel vous pouvez insérer des points. Les points peuvent 
aussi être déplacés comme dans le mode précédent, mais si vous cliquez sur la courbe 
entre deux points et déplacez un peu le pointeur en maintenant le bouton appuyé, vous insé-
rez un nouveau point. Le point inséré est un point lisse, dont les points de contrôle sont ali-
gnés avec le point créé et le reste quand vous les déplacez. Si vous souhaitez créer un point
d’inflexion vous devez le convertir après l’avoir inséré en utilisant l’outil Point d’inflexion 
(page 45).

Supprimer des points 
Cliquez sur ce bouton pour supprimer les points sélectionnés. Pour sélectionner plusieurs 
points, appuyez sur la touche Maj et cliquez sur ceux-ci sans relâcher la touche, puis cliquez
sur le bouton Supprimer des points ou appuyez sur la touche Suppr.

Convertir en courbe 
Ce bouton permet de convertir une portion de courbe en segment de droite et inversement. 
Dans une courbe de Bézier, la partie de la courbe qui suit le point sélectionné (dans l’ordre 
de création) est transformée en segment. Si le point sélectionné est l’extrémité d’un seg-
ment, ce point et l’autre extrémité du segment reçoivent des poignées de contrôle (la forme 
ne change pas, mais vous pouvez déplacer les poignées pour courber le segment). Si né-
cessaire, le point est converti en point d’inflexion. Les extrémités de la ligne ont, au maxi-
mum, un point de contrôle.

Fermer la courbe 
Cliquez sur ce bouton pour fermer une courbe de Bézier ou un polygone en joignant le der-
nier point au premier par un segment. Le premier point possède une poignée légèrement 
plus grande que les autres.

Scinder la courbe 
Après avoir sélectionné les points de coupure, cliquez sur ce bouton pour scinder la courbe 
en deux éléments distincts ou plus.
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Point d’inflexion 
Cliquez sur ce bouton pour convertir les points sélectionnés en points d’inflexion (Figure 43). 
Les deux points de contrôle d’un point d’inflexion sont indépendants l’un de l’autre. Si les 
trois points ne sont pas alignés, la courbe change de direction au point d’inflexion et forme 
un angle.

Figure 43 : Point d’inflexion

Jonction lisse 
Cliquez sur ce bouton pour convertir un point d’inflexion ou une jonction symétrique en jonc-
tion lisse (Figure 44). Dans une jonction lisse, le point de la courbe et ses points de contrôle 
sont alignés et le restent quand l’un d’eux est déplacé, mais les points de contrôle peuvent 
ne pas être à la même distance du point de la courbe, ce qui permet d’avoir des rayons de 
courbure différents de part et d’autre de ce point.

Figure 44 : Jonction lisse

Jonction symétrique 
Cliquez sur ce bouton pour convertir un point d’inflexion ou une jonction lisse en jonction sy-
métrique (Figure 45). Dans une jonction symétrique, les points de contrôle sont symétriques 
l’un de l’autre par rapport au point de la courbe : les trois points restent alignés et le point de 
la courbe est au milieu des points de contrôle, ce qui donne le même rayon de courbure de 
chaque côté de celui-ci.

Figure 45 : Jonction symétrique

Réduire les points 
L’angle à partir duquel la réduction de points doit se produire peut être défini dans le champ 
Réduction de point de la page LibreOffice Draw – Grille de la boîte de dialogue Options (Ou-
tils > Options).
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Ajouter des commentaires à un dessin

Vous pouvez ajouter des commentaires à votre dessin Draw, comme vous pouvez le faire dans 
Writer ou dans Calc. Pour ajouter un commentaire :

 1) Sélectionnez Insertion > Commentaire dans la barre de menu. Une zone de commentaire 
apparaît, accompagnée d’une ancre contenant vos initiales, qui est située dans le coin supé-
rieur gauche de votre dessin. Draw ajoute automatiquement votre nom et la date en bas de 
la zone.

 2) Saisissez alors ou collez le texte dans la zone de commentaire (Figure 46).

Figure 46 : Commentaire dans un dessin

 3) Pour appliquer un formatage élémentaire au texte sélectionné, faites un clic droit et choisis-
sez l’option correspondante dans le menu contextuel.

 4) Pour supprimer un commentaire, faites un clic droit dans la zone de commentaire ou sur son 
ancre, ou cliquez sur le petit triangle noir ▼ dans le coin inférieur droit, et choisissez une op-
tion de suppression dans le menu contextuel.

 5) Pour déplacer un commentaire, cliquez et faites glisser son ancre (contenant vos initiales) 
jusqu’à l’endroit souhaité de votre dessin.

Si vous cliquez en dehors de la zone de commentaire, cette zone n’est plus visible, et seule reste 
affichée l’ancre du commentaire. Cliquez alors sur cette ancre pour que la zone de commentaire 
s’affiche à nouveau.

Si le commentaire a été écrit par un autre auteur, vous pouvez faire un clic droit et utiliser la com-
mande Répondre dans le menu contextuel. Votre texte va s’ajouter en dessous du texte de com-
mentaire précédent, mais l’ensemble ne constitue qu’un seul commentaire, avec une seule ancre.

Vous pouvez utiliser Affichage > Commentaires dans la barre de menu pour afficher ou masquer 
les commentaires du dessin.

Remarque

Pour que votre nom et vos initiales apparaissent dans un commentaire, vous devez saisir 
vos données d’identité en allant dans Outils > Options > LibreOffice > Données d’identi-
té et en remplissant les champs nécessaires. Si plusieurs personnes éditent le document, 
une couleur différente sera allouée à chaque auteur de commentaires.
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Connecter et fractionner des lignes

Dans Draw, il est possible de connecter des éléments de lignes séparés pour en faire une ligne 
unique ou de fractionner une ligne composée en éléments séparés.

• Pour connecter des lignes, sélectionnez-les puis choisissez Forme > Connecter dans la 
barre de menu. Le point final d’une ligne est relié au premier point de la suivante par un seg-
ment. Le résultat est une ligne polygonale ouverte, mais pas une forme fermée.

• Pour fractionner une ligne composée en éléments séparés, sélectionnez-la puis choisissez 
Forme > Fractionner dans la barre de menu. Après avoir cliqué dans l’espace de travail, 
vous pouvez sélectionner chaque élément, indiqué par un point de départ et un point final, et
le déplacer à un nouvel emplacement.

Système de coordonnées

Axes des abscisses et des ordonnées

L’abscisse est la position horizontale d’un objet et l’ordonnée sa position verticale. Les règles n’af-
fichent pas les signes moins (-)si la coordonnée est négative, mais il apparaît bien dans le champ 
qui indique la position dans la barre d’état et dans les champs de la boîte de dialogue Position et 
taille.

L’espace de travail

L’espace de travail est plus grand que la page de dessin. Il s’étend de la largeur d’une page à 
droite et à gauche de celle-ci et d’une demi-page au-dessus et en dessous. La taille de la partie 
imprimable de la page de dessin est indiquée par les parties plus claires des règles horizontales et
verticales.

Vous pouvez dessiner des objets totalement ou partiellement à l’extérieur de la page de dessin. 
Cependant, quand la page est imprimée, toute partie d’un objet qui n’est pas dans la zone impri-
mable n’est ni imprimée, ni enregistrée, ni exportée. Cela permet d’utiliser les zones qui entourent 
la page comme brouillons pour la création des objets.

Position d’un objet

Les coordonnées des objets et des guides de capture sont relatives à l’origine.
L’origine par défaut des coordonnées (la position (0,00 ; 0,00)) est le coin supérieur
gauche de la partie imprimable de la page de dessin (le point d’intersection de la
marge supérieure et de la marge gauche). Vous pouvez déplacer l’origine par dé-
faut, en cliquant sur l’intersection des règles et en la tirant jusqu’à la position sou-
haitée. Des lignes guide apparaissent pendant le déplacement pour vous aider à
placer l’origine. Cette position ne s’applique qu’à la vue courante et n’est pas enregistrée avec le 
document.

La zone à l’intérieur de l’origine par défaut est utilisée pour la grille quand les options Aligner sur la 
grille et Afficher la grille sont activées.

Pour remplacer l’origine à son emplacement par défaut dans le coin supérieur gauche de la page, 
il suffit de faire un double-clic à l’intersection des règles où vous avez initié le déplacement.
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Précision

Draw utilise de manière interne des valeurs entières en 1/100 mm. Il n’est donc pas possible de 
définir une position exacte en 1/8 de pouce. De plus, de nombreux champs sont limités à deux dé-
cimales.

Pour travailler avec un maximum de précision, ouvrez la page LibreOffice Draw – Général de la 
boîte de dialogue Options (Outils > Options) et sélectionnez le millimètre dans le champ Unité de
mesure. Les règles affichent aussi les unités métriques, mais, pour utiliser votre unité de mesure 
préférée, faites un clic droit sur la règle et sélectionnez cette unité dans le menu contextuel.
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